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Welcome 
Thanks for your purchase of Q2QConnect by VARC Solutions. Q2QConnect is the only tool of its 
kind to quickly connect Quickbase to QuickBooks Desktop (Pro, Premier, or Enterprise 
Solutions). 
 
In this manual, we’ll walk you through installation, connecting, and configuring Q2QConnect to 
sync the available lists and transactions you want.  Also included are FAQs, Tips, and Best 
Practices to help you set up your Quickbase application like a pro! 
 
We also acknowledge that some folks might feel more comfortable having our developers do 
the work for you, which we are happy and standing by to do. If you’d prefer us to get things set 
up and working for you, please call our sales team at 281-412-6914 and we’ll get a developer 
assigned to do the work. 
 

Overview 
Q2QConnect helps you sync the following transactions between Quickbase and QuickBooks: 

 Estimates 
 Sales Orders 
 Invoices and Invoice Paid Status 
 Credit Memos 
 Payments 
 Purchase Orders 
 Item Receipts 
 Bills, Bill Paid Status, and Bill Credits 
 Credit Card Charges and Credit Card Credits 
 Timesheets 
Transactions are synced FROM Quickbase TO QuickBooks, and relevant information is 
reported back to Quickbase to keep things organized. Fields that are written back to 
Quickbase are indicated in Red on the transaction mapping screens. See Mapping section of 
this manual for more information. 
 

Q2QConnect helps you sync the following lists between Quickbase and QuickBooks: 
 Customers 
 Vendors 
 Items 
 Employees 
Customer and Vendor lists are synced FROM Quickbase TO QuickBooks. For Items and 
Employees, you can choose which direction the sync will flow. 
 
PRO TIP: For accounting purposes, we recommend syncing Items and Employees FROM 
QuickBooks TO Quickbase. 
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Installation 
Let’s get Q2QConnect installed! To ensure things run smoothly, please complete the installation 
steps in the following order. You will need to be logged into a computer with Administrator rights. 
Then, follow the installation steps below: 
 

Preparing for Install 
In order for Q2QConnect to establish a connection with your Quickbase app, you’ll need to 
create an application token. Don’t let that scare you, we’ll walk you through the process. 
 
Create Quickbase Application Token 

1. Sign in to your Quickbase application as a user with admin privileges. 
2. Click the Home button. 
3. Click the Settings gear icon. 

 
4. Click App properties. 
5. Click the Manage Application Token link below Advanced settings: security options. 

 
6. Click Create New Application Token. 
7. Enter Q2QConnect in the Description field. 
8. Click the checkmark next to OK to Copy. 
9. Click OK. 

 
10. You’ll copy and paste the Application Token into Q2QConnect later in the installation process. 
11. If you need to get back to the Manage Application Tokens page, repeat the steps above. 
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Download the QuickBooks Desktop SDK and Q2QConnect Installation Files 
1. VARC Solutions emailed you a link to the QuickBooks Desktop SDK (otherwise known as 

“QBFC13”) and the most recent version of Q2QConnect. 
2. Click on the link in your email to access our ShareFile repository. Or visit 

https://tinyurl.com/q2qconnect-current 
3. Click Select All. 
4. Click Download. 

  
5. Click to open the Files.zip file in your downloads folder. (Depending on your operating 

system, you may need to double-click on Files.zip to open the downloaded zip file.) You 
should now see a QBFC 13 Install File and a Q2QConnect zip file. 

  
6. Select and drag both files to your desktop for easy access. 
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Install the QuickBooks Desktop SDK (QBFC 13) 
1. Double-click on the QBFC 13 Install file. 
2. Double-click on the qbsdk130.exe file. 
3. Click Yes several times (as many times as necessary) until the QuickBooks SDK13.0 – 

InstallShield Wizard appears. 

 
4. Click Next several times (as many times as necessary) until the installation copies the 

files and finishes installation. 
5. Click Finish. 
6. You can safely close any Getting started window that opens after installation. 
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Q2QConnect Installation 
At this point, you are ready to install Q2QConnect with the previously downloaded Q2QConnect 
installation zip file. The Q2QConnect installation file should be on your Desktop. 
 
Multi-User Installs (V 3.25 and newer) 
For multi-user installs of Q2QConnect, you’ll complete the installation and licensing steps on 
each computer. We’ll alert you to specific multi-user steps to complete as you go. 
 
Install Q2QConnect 

1. Double-click on the Q2QConnect installation zip file on your desktop. Another window 
will open. 

2. Double-click on the Q2QConnect installation file in the window that opens. 
3. Double-click on the setup.exe file. 

 
4. Click Yes until the Q2QConnect – InstallShield Wizard appears. 
5. Click Next. 
6. Click Install. 
7. Click Yes (if prompted). 
8. Click Finish. 
9. The installer will add a Q2QConnect program icon on your desktop. 

 
10. At this point, you can safely delete the downloaded zip and install files. 
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Configuring Q2QConnect 
Nicely done! Now that Q2QConnect is installed, it’s time to get the application configured and 
activate your Q2QConnect license. 
 
Open QuickBooks 

1. Open QuickBooks as normal and open your desired QuickBooks company file. 
2. Login as an Admin user. 
3. From the File menu, select Switch to Multi-user Mode. 

Launch Q2QConnect and Request License 
1. Switch to your desktop and double-click on the Q2QConnect program icon. 
2. Enter your name, company name, and email address in the Q2QConnect License Status 

window. 
3. Click Request License. This sends an email to VARC Solutions to grant your license. This can 

take up to 1 business day. To expedite, call VARC Solutions at 281-412-6914. 

 
4. Your license status should now show as Pending.  
5. Once your license has been granted, you will receive an email confirmation. 
6. After receiving email confirmation, click the Refresh button on the License Status window. 
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7. Your License Status should change to Granted, and your License Code should 
automatically populate. 

 
8. Click Configure License. 
 

Establish Q2QConnect Connection Settings 
You are almost home! Now that Q2QConnect is installed and your license has been granted, it’s 
time to establish your connection settings. This is where you’ll get Quickbase and QuickBooks 
talking to one another! 
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Configuration: Single-user vs Multi-user 
1. Single-user Configurations: 

a. Select Single-user. Continue to Configuration: Quickbase Section below. 
 

2. Multi-user Configurations (V 3.25 and newer): 
a. For the FIRST user being configured: 

 Select Single-user. You will change the setting to Multi-user later. Continue to 
Configuration: Quickbase Section below. 
 

b. For subsequent users: 
 Select Multi-user. 
 Click the  button to browse to the shared network folder where configuration 

settings are stored. 
 Click OK. 
 Click Yes when prompted to copy the configuration settings. The rest of the 

connection settings should be populated for you. 

 
 Click Test Connection on both the Quickbase and QuickBooks sections. 
 Click Install License. 
 Accept the License Agreement and click OK. 
 Click OK. 
 Exit Q2QConnect. 
 At this point, you will skip the remaining configuration steps and proceed to the 

instructions for Connecting and table/field Mapping if that hasn’t already been 
completed. 
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Configuration: Quickbase Section 
This needs to be completed by a Quickbase Admin user with full access to all tables within 
your application. For example, they need to be able to add and modify fields. 
 

1. Enter your Quickbase Realm. For example, when you login to your Quickbase 
application, the Realm will be something like the bolded text here: 
https://varcsolutions.quickbase.com/db/bmg6k2bmy 

2. Enter your Quickbase login Email Address or Screen Name and Password. This can be 
changed later as needed. 

3. Click Connect to Quickbase and select from the list of available applications. 

 
4. Next, copy and paste your Application Token from Quickbase. The application token 

should have been created earlier in the Preparing for Install steps. 
5. Click Test Connection. 

 
 

Note: Q2QConnect is currently not compatible with Quickbase 2 Step Authentication. If 
necessary, disable 2 Step Authentication in your realm/policy or account settings. Learn how 
to enable/disable here: https://help.quickbase.com/user-assistance/two_step_auth.html 
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Configuration: QuickBooks Section 
You should already be logged into your desired QuickBooks company file as an Admin user, in 
Multi-user Mode. 
 

1. Click Connect to currently open QuickBooks company file. QuickBooks should open a 
QuickBooks – Application Certificate window. 
a. If this window is accidentally closed, you can find it again by switching to QuickBooks 

in Single-user Mode, and selecting Edit > Preferences from the menu. Click 
Integrated Applications. Click the Company Preferences tab. Select Q2QConnect 
and click Properties or Reauthorize. 

2. Click Yes, always; allow access even if QuickBooks is not running. 
Yes, whenever this QuickBooks company file is open will also work if you prefer. 

3. Click Allow this application… to provide sufficient rights for Q2QConnect to sync data 
with QuickBooks. 

 
4. Click Continue. 
5. Click Done (if prompted) in the Access Confirmation window. 
6. Click OK. 
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7. Click Install License. 

 
8. Review the Q2QConnect License Agreement, and select I accept the terms of the 

license agreement. 

 
9. Click OK 
10. Finally, call VARC Solutions at 281-412-6914 to request activation prior to using the 

application. Once VARC Solutions confirms your activation, you can launch Q2QConnect, 
connect Quickbase and QuickBooks, and proceed with the mapping process. 
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Multi-User Configuration (V 3.25 and newer) 
At this point, you have installed and licensed Q2QConnect for your first user, however the 
configuration is set for Single-user. If you purchased a multi-user license, you need to enable 
the multi-user configuration. 

1. Create a shared network folder, with full read/write access, where the Q2QConnect 
configuration files can be stored and accessed by your desired users. 
a. Make a note of the full path to this shared folder. The file path specified for all 

installations needs to match. Example, if your configuration file path is 
M:\<foldername or path> on one computer, the same path must be used on other 
computers. If you specify a UNC path such as \\servername\path on one computer, 
that same path must be used on other computers. 

2. Select Settings > Database Connections from the menu. 
3. Select Multi-user. 
4. Click the  button to browse to the shared network folder created in Step 1 above. 

 
5. Click OK. 
6. Click Save Settings. 
7. Click Close. 

 
At this point, you can either repeat the installation and licensing steps for subsequent users or 
continue with connecting and mapping tables and fields as instructed below. 
 
When you install Q2QConnect for subsequent users, the configuration and mapping will be 
shared across all licensed users. 
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Connecting Quickbase and QuickBooks 
At this point, you have installed Q2QConnect and have an active license. Q2QConnect has 
stored the Quickbase and QuickBooks information, along with your license so you won’t need 
to enter them again.  

When you are ready to use Q2QConnect, open the program using your Q2QConnect application 
shortcut and click Connect. 

1. Double-click the Q2QConnect application shortcut on your desktop. 
2. Click Connect. This will initiate a connection to Quickbase and QuickBooks. 

 
 

NOTE:  When Quickbase and QuickBooks are connected, the Base and Books indicators on the 
bottom of the screen will show the connections in green. 

 
 
PRO TIP: If you right-click on the bottom row of Q2QConnect that shows Base and Books, you 
can individually connect or disconnect Quickbase or QuickBooks as needed. 
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Mapping 
Mapping is the process of defining which QuickBooks fields correlate to matching tables and 
fields in Quickbase. Without mapping, Q2QConnect won’t know where to get or send the 
information.  
 
As an example, on the QuickBooks Customer:Job list, there are Company Name, Phone 
Number, Email Address, and Bill To/Ship To Address fields. Which Quickbase table stores 
customers? And which fields in that table should be linked to name, phone, email, and address 
fields in QuickBooks? Welcome to mapping! 
 
The following diagram shows mapping of the Client Name in Quickbase to the Customer Name 
in QuickBooks.  
 

 
 
Q2QConnect makes it easy to map the available lists and transactions you plan to sync. And this 
mapping process only needs to be completed one time. However, if you make changes to your 
Quickbase application, or start using additional fields later, you can update your field mappings 
at any time. 
 

 First, we’ll show you how to map your lists 
 Then, we’ll show you how to map transactions 
 Lastly, we’ll help you avoid some of the more common mapping mistakes and share 

some mapping best-practices. 
 
Refer to the individual list or transaction to see a complete list of fields you can map in 
Q2QConnect. 
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General Mapping Instructions 
1. Click Settings > Maps – Lists or Maps – Transactions from the menu. 

 
2. Each tab represents a list or transaction. Select the appropriate list or transaction tab to map. 
3. Click the Quickbase Table drop-down list and select the appropriate table that 

corresponds to the list/level in QuickBooks. 

  
4. Click Save Tables / Reset Field Names. 

 
Pro Tip: When mapping lists and transactions, click the Show details box. Later, when 
transferring data between Quickbase and QuickBooks, Q2QConnect will show the 
information being exchanged in detail. 
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5. For each field you want to map between Quickbase and QuickBooks, click the Quickbase 
Field drop-down list and select a matching field. Pro Tip: We suggest creating Q2Q 
formula fields to easily change data without having to remap fields later. 

 
6. Click Apply Changes or Save & Close. 

 
Pro Tip: It’s not necessary to map every field between Quickbase and QuickBooks. However, 
there are some REQUIRED fields. See the particular list or transaction page in this manual 
for a list of required fields. 

Mapping Lists 
Let’s get your lists mapped! Follow the general mapping instructions on Page 15. Then, refer to 
this section for specifics about each list. 

 
 
In this section, we’ll cover mapping the following lists: 

 Customers 
 Vendors 
 Items 
 Employees 

 
Remember: To start mapping lists, open Q2QConnect, click Connect, then click Settings > Maps 
– Lists from the menu. Fields shown in Red font are written back to Quickbase. Refer to the 
individual list to see a complete list of fields you can map in Q2QConnect.  
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Customers 
For Customers, you need to specify the number of levels that you have in QuickBooks; 
Customers, Jobs, Sub-Jobs, etc. 

You can map up to 5 customer levels, however we recommend keeping it simple and mapping 
only up to 2 customer levels. For example, if you have customers AND jobs in QuickBooks, 
select 2 Levels. 
 

Customer  (Level 1) Example: Acme Co 

 Job  (Level 2) Example: Acme Co: Acme Telephone 
 

Next, for each table/level, map specific fields between Quickbase to QuickBooks.   

  
QuickBooks Required Fields: 

 Customer Name 
 

Fields That Are Written Back to 
Quickbase: 

 Open Balance 
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Customer Mappable Fields (Level 1) 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 
Address Info Tab 

 
 
 
  Payment Settings Tab 

 
 
Sales Tax Settings Tab 

 
 

Additional Info Tab 
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Job Mappable Fields (Level 2-5) 
In addition to the standard customer mappable fields, he following highlighted QuickBooks Job 
fields are mappable to Quickbase: 
 

 
 
Pro Tip: If IsActive is mapped on the Customer level, it must be mapped at each lower level. 
 
  

QuickBooks Required Fields: 
 Job Name 
 

Fields That Are Written Back to 
Quickbase: 

 Open Balance 
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Vendors 
For Vendors, there is only 1 table level to map. In the example below, we are mapping the 
Vendors table in Quickbase to the Vendors list in QuickBooks. 

  

  

QuickBooks Required Fields: 
 Vendor Name 
 

Fields That Are Written Back to 
Quickbase: 

 Open Balance 
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Vendor Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 
Address Info Tab 

 
 
 
  

Payment Settings Tab 

 
 
Tax Settings Tab 

 
 

Additional Info Tab 
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Items 
For Items, you need to specify the number of levels that you have in QuickBooks; Items, Sub-
Items, etc.  

You can map up to 5 item levels, however we recommend keeping it simple and mapping only 
up to 2 item levels. For example, if you have Item and Sub-Items in QuickBooks, select 2 Levels. 
 

Item  (Level 1) Example: Trees 

 Sub-Item  (Level 2) Example: Trees: Fruit 
 

Q2QConnect also allows you to choose which direction data will transfer for Items; Quickbase 
to QuickBooks or QuickBooks to Quickbase.  

We recommend transferring data from QuickBooks to Quickbase for items to preserve the Item 
account mapping correctly in QuickBooks. 

In the example below, we are mapping the QB Items (child) table in Quickbase to the Items list 
in QuickBooks. 

  

  

QuickBooks Required Fields: 
 Item Name 
 Item Type 
 

Fields That Are Written Back to 
Quickbase: 

 Qty on Hand 
 
Note: In our Best Practices section of this 
manual, we suggest creating Q2Q Formula 
Fields, and mapping lists to those fields. 
However, when the direction of transfer is 
set from QuickBooks to Quickbase, you 
need to map to writeable, non-formula 
fields, as shown to the left. 
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Item Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 
Service Item Fields 

 
 
Inventory Part Fields 
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Employees 
Q2QConnect also allows you to choose which direction data will transfer for Employees; 
Quickbase to QuickBooks or QuickBooks to Quickbase.  

We recommend transferring data from QuickBooks to Quickbase for Employees to ensure 
Earnings and other important employee details in QuickBooks are properly set up and 
maintained. 

In the example below, we are mapping the Employees table in Quickbase to the Employees list in 
QuickBooks. 

 

  
QuickBooks Required Fields: 

 Base to Books: 
 At least one of the name fields 

(First Name, Middle 
Name/Initial, or Last Name) 

 
If the QuickBooks Employee List 
includes Middle Initial data, then 
you need to map the middle initial 
field. 
 

Fields That Are Written Back to 
Quickbase: 

 (none) 
 
Note: Payrates can’t be imported into 
QuickBooks. They must be manually 
updated in QuickBooks. 
 
In our Best Practices section of this 
manual, we suggest creating Q2Q Formula 
Fields, and mapping lists to those fields. 
However, when the direction of transfer is 
set from QuickBooks to Quickbase, you 
need to map to writeable, non-formula 
fields, as shown to the left. 
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Employee Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

Personal Tab 

 
 
Address & Contact Tab 
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Additional Info Tab 

 
 
Employment Info Tab 
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Structuring Your Quickbase Application for Mapping Transactions 
Mapping transactions requires at little more planning and likely some updates to your Quickbase 
application. 
 
Quickbase is a relational database, which means it can relate tables together for greater efficiency and 
data integrity. In practice, this means you wouldn’t have one table in Quickbase called “Invoices” that 
contains all the information you need to transfer to QuickBooks. If so, you would see incredible 
amounts of redundancy in the data, and dramatically increase the likelihood of data inconsistencies. 
 
Consider the following example, where you are mapping a 3 line invoice. To accomplish this using a 
single Quickbase table, in addition to the line item details of what you sold, each line would also 
contain the customer name, address, invoice #, invoice date, customer terms, etc. 
 
Instead, you would have a parent table named something like “Invoices” and a child table named 
something like “Invoice Items”. The “Invoices” parent table would store the information that applies 
to each line item (aka. header information), such as customer name, address, invoice #, invoice date, 
customer terms, etc. The “Invoice Items” child table would store the line item details, such as the item 
name, description, quantity, and price.  
 
You would create a relationship between the “Invoices” and “Invoice Items” tables so that each line 
item detail is associated back to the same “Related Invoice”. 
 

Which Table Do I Map? 
So, let’s assume at this point you’ve set up a parent Invoices table and a child Invoice Items table in 
Quickbase. Which table do you use for mapping in Q2QConnect? The answer: you map the child 
Invoice Items table. 
 
It’s beyond the scope of this manual, but you’ll need to edit your parent/child relationship to add 
“Lookup Fields” to your child table to pull header fields from the parent table into the child table. So, 
even though you are mapping the child table, the parent table header information will be included. 
 

 



Q2QConnect Manual  VARC Solutions 
 

Page 28 © Copyright 2020 VARC Solutions. All Rights Reserved. 

Mapping Transactions 
Let’s get your transactions mapped! Follow the general transaction mapping instructions on 
Page 15, and make sure you read the section on structuring your Quickbase application and 
which table to map BEFORE proceeding. 
 
Then, refer to this section for specifics about mapping each transaction. 
 

 
 

In this section, we’ll cover mapping the following transactions: 
 Customer Transactions: 

 Estimate 
 Sales Order 
 Invoice and Invoice Paid Status 
 Credit Memo 
 Payment 

 Vendor Transactions: 
 Purchase Order 
 Item Receipt 
 Bill and Bill Paid Status 
 Bill Credit 
 CC Charge 
 CC Credit 

 Employee Transaction 
 Timesheets 

 
Remember: To start mapping transactions, open Q2QConnect, click Connect, then click Settings 
> Maps – Transactions from the menu. 
 
Refer to the individual transaction to see a complete list of fields you can map in Q2QConnect. 
 
It’s also important to note here that Q2QConnect maps transactions only in one direction: from 
Quickbase to QuickBooks. So, Quickbase will be the Master in terms of where transactions are 
entered. And then those transactions will be transferred to QuickBooks using Q2QConnect. 
 
Fields shown in Red font are written back to Quickbase. 
 
PRO TIP: QuickBooks transactions sometimes have drop-down list fields, such as Customer 
Message, Template, Terms, Rep, ship Via, etc. Q2QConnect allows you to map these fields to 
Quickbase. However, the data coming in from Quickbase must match an available list option in 
QuickBooks exactly. See page 64 for more information. 
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Estimates 
In the example below, we have two tables in Quickbase; a parent table named Estimates and a 
child table named Proposal Items. We’re mapping the Proposal Items table in Quickbase to 
Estimates in QuickBooks. 

  
  

QuickBooks Required Fields: 
 Date 
 Customer Name 
 Item Name 
 

Fields That Are Written Back to 
Quickbase: 

 Quote No 
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Estimate Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

 
 

PRO TIP: You don’t need to map the line Total or Extended price. QuickBooks automatically 
calculates the total based on the Qty * Rate.  
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Sales Orders 
In the example below, we have two tables in Quickbase; a parent table named Sales Orders and a 
child table named Invoice Items. We’re mapping the Invoice Items table in Quickbase to Sales Orders 
in QuickBooks. 

  
  

QuickBooks Required Fields: 
 Date 
 Customer Name 
 Item Name 
 

Fields That Are Written Back to 
Quickbase: 

 S.O. No 
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Sales Order Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

 
 
PRO TIP: You can map the Customer Message field. However, if mapped, the Customer 
Message text in Quickbase must match one of the drop-down list options in QuickBooks 
exactly. 
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Invoices and Invoice Paid Status 
In the example below, we have two tables in Quickbase; a parent table named Invoices and a child 
table named Invoice Items. We’re mapping the Invoice Items table in Quickbase to Invoices in 
QuickBooks. For information about Invoice Paid Status, see Page 57. 

 

QuickBooks Required Fields: 
 Date 
 Customer Name 
 Item Name 
 

Fields That Are Written Back to 
Quickbase: 

 Invoice Number 
 Paid Status 
 Date Paid 
 Amount Paid 
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Invoice Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

 
 
PRO TIP: You can map the Customer Message field. However, if mapped, the Customer 
Message text in Quickbase must match one of the drop-down list options in QuickBooks 
exactly. 
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Credit Memos 
In the example below, we have two tables in Quickbase; a parent table named Credit Memos and a 
child table named Credit Memo Items. We’re mapping the Credit Memo Items table in Quickbase 
to Credit Memos in QuickBooks. 

  

  

QuickBooks Required Fields: 
 Date 
 Customer Name 
 Item Name 
 

Fields That Are Written Back to 
Quickbase: 

 Credit Memo Number 
 Paid Status 
 Date Paid 
 Amount Paid 
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Credit Memo Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

 
 
PRO TIP: You can map the Customer Message field. However, if mapped, the Customer 
Message text in Quickbase must match one of the drop-down list options in QuickBooks 
exactly. 
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Payments (From Customers) 
In the example below, we have a single table in Quickbase named Payments mapping to Payments 
in QuickBooks. A child table isn’t necessary since payments do not include multiple line items. 

  
 

Payment Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

 
 

QuickBooks Required Fields: 
 Date 
 Customer Name 
 

Fields That Are Written Back to 
Quickbase: 

 (none) 
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Purchase Orders 
In the example below, we have two tables in Quickbase; a parent table named Purchase Orders and 
a child table named PO Items. We’re mapping the PO Items table in Quickbase to Purchase Orders 
in QuickBooks. 

  
  

QuickBooks Required Fields: 
 Date 
 Vendor Name 
 Item Name 
 

Fields That Are Written Back to 
Quickbase: 

 (none) 
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Purchase Order Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
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Item Receipts 
In the example below, we have two tables in Quickbase; a parent table named Item Receipts and a 
child table named Bill Items. We’re mapping the Bill Items table in Quickbase to Item Receipts in 
QuickBooks. 

  
  

QuickBooks Required Fields: 
 Date 
 Vendor Name 
 Item Name 
 

Fields That Are Written Back to 
Quickbase: 

 Billable 
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Item Receipts Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

Items Tab 

 
 
Expenses Tab 
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Bills and Bill Paid Status 
In the example below, we have two tables in Quickbase; a parent table named Bills and a child 
table named Bill Items. We’re mapping the Bill Items table in Quickbase to Bills in QuickBooks. For 
information about Bill Paid Status, see Page 58. 

  
  

QuickBooks Required Fields: 
 Date 
 Vendor Name 
 Ref Number 
 Item Name or Expense 

Account 
 

Fields That Are Written Back to 
Quickbase: 

 Paid Status 
 Date Paid 
 Amount Paid 
 Billable 
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Bills Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

Items Tab 

 
 
Expenses Tab 
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Bill Credits 
In the example below, we have two tables in Quickbase; a parent table named Bills (where we 
enter Bills and Bill Credits) and a child table named Bill Items. We’re mapping the Bill Items table in 
Quickbase to Bills Credits in QuickBooks. 

  
  

QuickBooks Required Fields: 
 Date 
 Vendor Name 
 Item Name or Expense 

Account 
 

Fields That Are Written Back to 
Quickbase: 

 Paid Status 
 Date Paid 
 Amount Paid 
 Billable 

 
Note: When sending bill credits to 
QuickBooks, the total of all line 
items should be a positive number. 
The positive Bill Credit amount will 
be a reduction of Accounts Payable 
in QuickBooks. 
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Bill Credit Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

Items Tab 

 
 
Expenses Tab 
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Credit Card Charges 
In the example below, we have two tables in Quickbase; a parent table named Bills (where we 
enter Bills that are subsequently paid with Credit Card) and a child table named Bill Items. We’re 
mapping the Bill Items table in Quickbase to Credit Card Charges in QuickBooks. 

 
  

QuickBooks Required Fields: 
 Date 
 Payee Name 
 Item Name or Expense 

Account 
 

Fields That Are Written Back to 
Quickbase: 

 Billable 
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Credit Card Charges Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

Items Tab 

 
 
Expenses Tab 
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Credit Card Credits 
In the example below, we have two tables in Quickbase; a parent table named Bills (where we 
enter Bills, bill payments via Credit Card, and credit card credits) and a child table named Bill Items. 
We’re mapping the Bill Items table in Quickbase to Credit Card Credits in QuickBooks. 

 
  

QuickBooks Required Fields: 
 Date 
 Payee Name 
 Item Name or Expense 

Account 
 

Fields That Are Written Back to 
Quickbase: 

 Billable 
 

Note: When sending credit card 
credits to QuickBooks, the total of 
all line items should be a positive 
number. The positive Credit Card 
Credit amount will be a reduction 
of the related Credit Card account 
in QuickBooks. 
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Credit Card Credits Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

Items Tab 

 
 
Expenses Tab 
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Timesheets 
In the example below, we have a single table in Quickbase named Timesheets mapping to 
Timesheets in QuickBooks. A child table isn’t necessary since timesheets do not include multiple 
line items. 

  
 
Timesheet Mappable Fields 
The following highlighted QuickBooks fields are mappable to Quickbase: 
 

 
  

QuickBooks Required Fields: 
 Date 
 Employee Name 
 Payroll Item  

(if paying employees for 
time) 

 Customer:Job and Service 
Item (if time entry marked 
as billable) 

 
Fields That Are Written Back to 
Quickbase: 

 (none) 
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PRO TIP: To import time into QuickBooks, you must check the “Use Time Data to Create 
Paychecks” box on the Edit Employee, Payroll Info tab. 
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Transaction Numbering 
With Q2QConnect, you can select how customer transactions are numbered when transferred 
to QuickBooks.  

To specify transaction numbering, open Q2QConnect, click Connect, then click Settings > Maps 
– Transactions from the menu. Then, click the Numbering tab. 
 

You can select from two options for each transaction type:  

 Use Quickbase transaction number 
 Specify a Starting QuickBooks # 

 
If you select Use Quickbase, Q2QConnect will apply the transaction number found in Quickbase 
to the transactions being transferred to QuickBooks. 
 
If you select Starting QuickBooks #, specify the next available number, a starting number of 
your choosing, or a pattern such as S1000, EST101, I5000, or PO333. Q2QConnect will 
automatically increment and update the number after each transfer. 
 
You can enter a transaction text-number pattern, such as ABC-5000, using a dash "-" separator. 
However, the dash must be proceeded by text and followed by a number. Text following the 
dash or other special characters will not work. 
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Initial List Load (Optional) 
Once you’ve setup Q2QConnect and mapped your desired lists, you may want to load your 
Quickbase list tables with existing list entries from QuickBooks. There are three reasons you 
may want to do this: 
 

1. You have empty list tables in Quickbase and want to populate them with the list entries 
from QuickBooks 

2. You want to purge the Quickbase list table entries and replace them with the list entries 
from QuickBooks. This is helpful if your Quickbase application has test data you want to 
clear out. 

3. You want to append to the Quickbase lists with list entries from QuickBooks 
 

If you want to start with an empty Quickbase table, check the box next to Clear all Quickbase 
tables first. For a Customer Load, this means the mapped Customer table(s) in Quickbase will 
be cleared prior to the transfer. CAREFUL! There is no Undo button! 
 

You can also instruct Q2QConnect to set a TRUE flag for the OkToSend field in Quickbase. This 
means that in future syncs, Q2QConnect will see those list entries IF you have mapped the list’s 
OkToSend field to an OkToSend field in the Quickbase table. 
 

Pro Tip: In our Best Practices section of this manual, we suggest creating Q2Q Formula Fields in 
Quickbase to use for list and transaction mapping. However, Q2QConnect can’t update the 
contents of Quickbase formula fields. To use this Load feature, your lists need to be mapped to 
writable (non-formula) fields. 
 

Show Initial Load Menu 
1. Select Settings > Database Connections from the menu. 
2. Click the box next to Show “Initial Load” menu. 
3. Click Close. This setting will revert to unchecked after closing Q2QConnect. 
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Load Lists 
1. Click Connect. 
2. Select Initial Load > <List Name> Load from menu. 
3. Wait for Q2QConnect to evaluate your list information. 
4. Make appropriate selections in the Load window. 
5. Click Load. 
6. Repeat steps 1-5 for each list you wish to load. 
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Using Q2QConnect 
Once you’ve setup Q2QConnect and mapped your desired lists and transactions, you are ready 
to start using Q2QConnect! Congratulations! 
 
Start by telling Q2QConnect which list and transaction buttons you want to see on the 
Q2QConnect dashboard. 
 

Choose Lists/Transactions for Button Bar 
1. Select Settings > Choose Lists/Transactions from the menu. 

 
2. Click the box next to the lists and transactions you want to see on the Q2QConnect button bar. 

 
3. Click Save. 
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Filters 
Before syncing, review and update the list and transaction filter settings. You can 
include/exclude inactive records as well as specify the starting date or number of months of 
transactions to include. This ensures you are bringing in appropriate records, and can speed up 
the evaluation and transfer of data. 
 

List Filters 
1. Click Connect. 
2. Select Settings > Filters – Lists from the menu. 
3. Uncheck the box next to desired lists to exclude inactive records from being read. If the 

box is checked, inactive records will be read. 
4. Click Save & Close. 
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Transaction Filters 
1. Click Connect. 
2. Select Settings > Filters – Transactions from the menu. 
3. Select either a starting Fixed Date or a Fixed No. or Months to be included for each 

transaction. 
If you select a Fixed No. of Months, Q2QConnect will include that number of months 
prior to the current date. If you choose a Fixed Date, Q2QConnect will include all 
transactions from the selected date to today’s date. 

4. Click Save & Close. 

   
 

Invoice Paid Status 
The normal Invoice transaction in Q2QConnect transfers invoices from Quickbase to 
QuickBooks. The Invoices transaction filter is helpful because it reduces the amount of historical 
Quickbase data that Q2QConnect considers transferring. We normally set this to 1 Fixed No. of 
Months. 
 
You’ll use the Invoice button in Q2QConnect for your daily transfer of new or changed invoices. 
However, what if you just want to update Quickbase with the paid status of invoices from 
QuickBooks? You might need to look at invoices dated farther back in the past (example: an 
invoice created 4 months ago that was finally paid today!). Instead of having to keep changing 
the Invoices transaction filter, just use the Invoice Paid Status button, and expand the number 
of months it considers. 
 
Set your Invoice Paid Status transaction filter to something like 4 months, and Q2QConnect will 
review the last 4 months of invoices, and update Quickbase if the paid status on those invoices 
has changed. Note: you must also map the Invoices Paid Status field in Q2QConnect with a Paid 
Status field in Quickbase. 
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Bill Paid Status 
The normal Bills transaction in Q2QConnect transfers bills from Quickbase to QuickBooks. The 
Bills transaction filter is helpful because it reduces the amount of historical Quickbase data that 
Q2QConnect considers transferring. We normally set this to 1 Fixed No. of Months. 
 
You’ll use the Bills button in Q2QConnect for your daily transfer of new or changed bills. 
However, what if you just want to update Quickbase with the paid status of bills from 
QuickBooks? You might need to look at bills dated farther back in the past (example: a bill 
created 4 months ago that you paid today). Instead of having to keep changing the Bills 
transaction filter, just use the Bill Paid Status button, and expand the number of months it 
considers. 
 
Set your Bill Paid Status transaction filter to something like 4 months, and Q2QConnect will 
review the last 4 months of bills, and update Quickbase if the paid status on those bills has 
changed. Note: you must also map the Bills Paid Status field in Q2QConnect with a Paid Status 
field in Quickbase. 
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Sync List or Transaction 
In the example below, we are syncing Customers from Quickbase to QuickBooks. The same 
steps apply regardless of which list or transaction you are transferring using Q2QConnect. 
 
Sync 

1. Click Connect. 
2. Click on the desired list or transaction button. 
3. Click Select All if you want all entries transferred or click the Flag for Bulk Send box next 

to the entries you want to transfer. 
4. If you have selected multiple entries, click Send Selected. Otherwise, click Send next to 

the individual entries to transfer. 
5. Click OK on the informational window after the transfer is complete. 

 
Q2QConnect: Select Entries to Send 

 
 
Confirmation Window 
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Best Practices 
We’ve compiled the following suggestions and best practices to help you be successful using 
Q2QConnect. 
 

Q2Q Starter App 
 If you haven’t built out your Quickbase app yet, you might consider purchasing our 

Q2QConnect Starter App. We’ve built an app with all the tables and fields you would 
need to get started in minutes. Call us at 281-412-6914 for current pricing. 

 

Field Mapping 
 Instead of mapping normal fields in Quickbase, set up Formula fields (text, numeric, or 

date) instead which reference your normal Quickbase fields. For example, instead of 
mapping a Customer Name field in Quickbase, set up a formula-text field called “Q2Q – 
Customer Name”. Edit the formula for that field to point to the normal Customer Name 
field. Then, in Q2QConnect, select the Q2Q – Customer Name field when mapping.  
 

This allows you to change the formula/contents of that field later without having to 
change the mapping in Q2QConnect. This approach makes the connection and mapping 
more flexible going forward.  

 

Formula-Text Field 

 
 

Map Formula-Text Field 
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Ok To Send 
 When mapping lists and transactions in Q2QConnect, scroll to the bottom of the field 

list and you’ll see an OkToSend field. This allows you to control in Quickbase which list 
entries or transactions Q2QConnect can see. You can create an OkToSend formula-
checkbox field in Quickbase, and then build a formula to restrict which transactions flow 
through Q2QConnect. For example, you might have an approval process in Quickbase, 
and if a manager’s initials aren’t found, the OkToSend box is not checked. Q2QConnect 
won’t see the transaction until the manager has approved the entry. The possibilities of 
this technique are endless. Call us for a consultation to explore how this could be used 
to maximize your workflow. 

 
Formula-Checkbox Field 

 
 

Mapping the OkToSend Field 
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Table Levels 
 With Q2QConnect, you can map up to 5 customer levels and up to 5 item levels. This 

matches the capabilities of QuickBooks. However, in practice, mapping more than 2 
levels makes your Quickbase application and mapping increasingly complex. If you find 
yourself mapping more than 2 table levels, you may want to evaluate whether your 
Quickbase application is set up correctly. Contact us for a consultation if you need help 
in this area. 

 
 
Pro Tip: Even though you may have multiple levels (Customers, jobs) in Quickbase, you 
can choose to just send 1 level to QuickBooks. 
 

Syncing Multiple Levels 
 If you have established multiple table levels for customers (such as Customers – Level 1 

and Jobs or Projects – Level 2) or Items (Items – Level 1 and Sub-Items – Level 2), make 
sure and sync the PARENT (or highest level) 1st. Then, sync the 2nd highest level, etc. in 
progression. When you sync the parent item first, you’ll ensure that when the next level 
is synced, the related parent item will be there. If you don’t follow this approach, you 
could end up adding orphaned level 2 entries that have to be manually edited later. 

 
 

Syncing Lists and Related Transactions 
 If you are syncing Customers and related customer transactions such as invoices, 

payments, etc. always sync the list first to ensure you have brought in new customers. 
Otherwise, your transaction sync might fail due to a missing customer. This concept also 
applies to vendors and vendor transactions where you would want to sync your vendor 
list before syncing vendor transactions. 
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Initial Quickbase Table Population from QuickBooks 
 If you are starting out with a fully populated QuickBooks file and an empty Quickbase 

application, make sure and use our Q2QConnect Load utility to populate your Quickbase 
list tables with data from QuickBooks. 
 
See Page 53 for instructions on loading initial tables. 

 
 

Show the Details During Sync 
 When mapping your lists and transactions, check the box next to Show details. When 

syncing, Q2QConnect will show you more information about what is being synced which 
can be very helpful. 

 
Show Details Option 

 
 

More Details During Sync 
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Mapping Transaction Drop-Down List Fields 
 QuickBooks transactions sometimes have drop-down list fields, such as Customer 

Message, Template, Terms, Rep, ship Via, etc. Q2QConnect allows you to map these 
fields to Quickbase. If you choose to map such fields, you’ll want to create a multiple 
choice field in Quickbase and only include options that are an exact match of the data in 
QuickBooks. Otherwise the synced transaction will not flow into QuickBooks. 

 
Drop-Down List Fields in QuickBooks 

 
 

Multiple-Choice Field in Quickbase 
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Mapping Field in Q2QConnect 

 
 

FAQs 
We’ve collected some of the most common Q2QConnect questions and answers below. If you 
have a question not answered here, call us at 281-412-6914, or submit a question through our 
website contact us form at https://varcsolutions.com/contact-us. 
 

Lists 
How do I handle Items that are double-sided (including both sales and purchase info)? 
In QuickBooks, if an item needs to be double-sided (including both the sales/income and 
purchase/expense sides), that option needs to be specified within QuickBooks. 
 
How do I track the Preferred Vendor for an Item? 
If you are transferring Items from QuickBooks to Quickbase, the Preferred Vendor will only 
populate to a text-only field; it will not go into a Related Vendor field. If transferring Items from 
Quickbase to QuickBooks, you can use the Related Vendor field to move the information to 
QuickBooks.  
 
For Address State fields, do I use the state name or abbreviation? 
The Quickbase address field type spells out the state name “Texas” verses using the state 
abbreviation “TX”.  QuickBooks typically uses the 2-digit state abbreviation. Q2QConnect 
translates from “Texas” to “TX” and puts the abbreviation in QuickBooks. If you have TX in the 
Quickbase state field, Q2QConnect can’t do the translation. Q2QConnect will push all of the 
data that you have but it will show that the address does not match and will show up for sync 
again. The resolution is to use the State field from the Quickbase address field type, or create a 
state field in Quickbase that lists states using the name instead of the abbreviation. 
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Transactions 
How do I update the Quickbase Paid Status on Invoices and Credit Memos that have changed 
status? 
If you have an invoice or credit memo that has been marked paid, but something changes in 
QuickBooks or Quickbase to make that transaction unpaid, you will need to sync the changes 
from Quickbase (such as an increase in the invoice amount, reduction of a payment, or 
correction of a payment to another customer). Then sync again to pick up the paid status 
change. 
 
How do I map transactions that include multiple line items? 
In order to ensure that multi-line transactions (Bills, invoices, etc.) map correctly, Quickbase 
needs to be set up with two tables; one for the header (parent) and one for the line item detail 
(child). Q2QConnect mapping should use the child table. Make sure to edit your parent/child 
table relationship and add lookup fields to the child table for the required header/parent fields, 
such as transaction date, client name, address, ref #, etc. 
 
How do I ensure Q2QConnect applies payments to invoices correctly? 
You have two options in Q2QConnect: 
 

Option 1: Auto Apply Payment is Checked 
This means that Q2QConnect will apply payments to the oldest invoice first if the invoice 
number is not specified. If there is an over-payment on a specified invoice, the amount will 
apply to the next sequentially dated invoice. If there are no more invoices, then the 
overage will be left on the account as a credit to be applied later. 
 
Option 2: Auto Apply Payment is Not Checked 
The system will apply payments to invoices specified and add an additional payment for 
any overage amount that is put on account (each payment with an overage will create a 
separate payment). For payments without invoices specified, a payment will be added to 
the customer’s account as a credit to be applied later. 
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Additional FAQs 
Are there any field limits I should be aware of? 
All of the settings and field-length restrictions in QuickBooks will be followed when transferring 
information to QuickBooks using Q2QConnect. If the QuickBooks character limit is exceeded, 
the name and/or transaction will not go into QuickBooks, but an error message/error log will 
indicate the problem. 
 
For fields potentially longer than the character limit, we recommend you set up a formula field 
that truncates the field to the max character limit, then map this formula field to the matching 
QuickBooks field in Q2QConnect. This formula field can be pulled through to child tables in 
QuickBase via table relationship lookup fields, if you are using it on transactions. 
 

Field Maximum Characters 
Account Name 31 
Account Numbers 7 
Amount 20 
Customer message (Invoices) 101 
Customer, Vendor Names 41 
Employee Name (first and last) 25 
Item Name 31 
Item Part Number 31 
Item Description (Invoices) 4095 
Job Description 99 
Memo (Transaction) 4095 
Notes in Shipping/Billing Address 41 
Ship to Name 41 
Invoice Number Field 11 

 
What should the path be to my QuickBooks company file? 
If your QuickBooks company file is stored on a server, then you’re able to get to the file through 
a mapped drive or through a direct connect through the server.  When using Q2QConnect, 
make sure the path used to get to QuickBooks is the same. Q2QConnect validates the path and 
filename to ensure the correct QuickBooks file is synced. 
 
In Q2QConnect, verify the company file path by clicking Settings > Database Connections.  
 
In QuickBooks, verify the company file path by clicking File > Open Previous Company. Both 
paths and should match.  
 
Note: If you find the paths are different, open the QuickBooks file using the same path as listed 
in Q2QConnect. This can happen when the QuickBooks file is upgraded and the file is opened 
through another path. 
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Should I include my chart of accounts account number when specifying expense accounts to 
sync?  
In QuickBooks the account name and account number are two separate fields. If you are 
syncing the expense side of transactions to QuickBooks, only use the account name; not the 
account name and number. 
 
How should I indicate sub accounts when specifying expense accounts to sync? 
If you are syncing the expense side of bills to QuickBooks, use the full account name. Ie. if the 
account is a sub-account on the chart of accounts, then concatenate the parent account and 
sub-account with a colon (“:”) and no spaces. 
 

Example:  Professional Fees:Accounting 
 

How should I indicate sub customers (aka “Jobs”) when syncing customer:job names? 
If you are syncing Customers that have Jobs and you are syncing the whole job name, 
concatenate the customer name and job name separated by a colon (“:”) and no spaces.  
 

Example:  ABC Company:Job 1234 
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Minimum System Requirements 
The following system requirements must be met for a successful install and use of Q2QConnect. 
 

  Minimum requirement 

Processor Intel® or AMD processor; 2 GHz or faster processor 

Operating 
system 

Microsoft 8.1, 10 or Windows 11. Current version of QuickBooks (2022) 
will not install on Windows 7. 
 
For server installations: Windows Server 2008 R2 SP1 and Higher 
(Windows Server 2012, 2016, or 2019 preferred).  
 
Q2QConnect is not compatible with Mac OS. 

RAM 1 GB or more of RAM (8 GB recommended). More RAM may be required 
for larger Quickbase applications. For example, performance testing 
found that evaluating a customer list with 44,400 records required 
450MB of RAM.  

Hard disk space 100 MB or more of available hard-disk space (includes installation of the 
QuickBooks Desktop SDK, aka QBFC13). 

Internet Internet connection required for software activation, connection to 
Quickbase, and transfer of data to QuickBooks Desktop. 

QuickBooks 
Version 

QuickBooks Desktop 2015/15.0 or higher (Pro, Premier, or Enterprise 
Solutions). Current version recommended. QuickBooks Online and 
QuickBooks for Mac not supported.  

Admin Rights Admin rights on local installation computer required, as well as modify 
access to installation folders, subfolders, and files (c:\varcsolutions\) 
 
When setting up Q2QConnect, the initial connection to your Quickbase 
application must be done by an admin user with full access to all tables 
and fields. 
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Troubleshooting 
The following are problems you may encounter and our recommended solution. If you 
encounter a problem not listed here, please call us at: 281-412-6914. 
 

Installation Problems 
 
Can’t install Q2QConnect as a non-admin computer user 
The most common problem we see is an error during install. This is usually the result of 
insufficient privileges on the installation computer. Make sure you are installing the program as 
an Admin user with modify rights to the installation folder, subfolder, and files. 
 
Installing QuickBooks Desktop SDK AFTER Q2QConnect Install 
For proper install and operation of Q2QConnect, the QuickBooks Desktop SDK (aka QBFC13) 
must be installed PRIOR to installing Q2QConnect. If necessary, uninstall Q2QConnect, install 
QBFC13, then reinstall Q2QConnect. 
 
Q2Q Connect Doesn’t Support Quickbase 2 Step Authentication 
2 Step Authentication must be disabled in your realm/policy or account settings for 
Q2QConnect to connect with Quickbase. Learn how to enable/disable here: 
https://help.quickbase.com/user-assistance/two_step_auth.html 
 

Mapping Problems 
 
When mapping fields in Q2Q, sometimes the fields don’t show below. What’s the resolution? 
If you select a table and the fields do not show below, click on another table name then back to 
the desired table and the fields should populate. 
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Q2QConnect Operation Problems 
 
Why can’t I create a connection to QuickBooks? 
QuickBooks should be open prior to connecting Q2QConnect. Also, review your connection 
settings under Settings > Database Connections. If you have specified an Open Mode of Multi-
User for QuickBooks, make sure you are logged into QuickBooks and toggled into Multi-User 
Mode (QuickBooks: File > Switch to Multi-User Mode). The modes need to be the same 
between Q2QConnect and QuickBooks. 
 
Database Connection Settings 

 
 
QuickBooks Mode: 

 
 
Why can’t I access the Q2QConnect Settings? (Multi-user Configurations) 
In a multi-user configuration, the global settings file is shared by all licensed users. If a user is 
currently editing the settings, other uses are not able to edit the settings. 
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A Quickbase application user or password change is causing a “Connection to QuickBase 
failed” error message. 
If the user name or password in Q2QConnect refers to a user id/pw that has been changed in 
your Quickbase application, you need to update that authentication information in 
Q2QConnect using the following instructions. 
 
Quickbase Connection Error Message-Popup 

 
 

Quickbase Connection Error Message-Status Bar 
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Modify Connection Settings 
1. Open Q2QConnect 
2. Click Connect (and select specific connection if applicable). 
3. Click Settings > Database Connections for the current connection. 
4. Click Modify at the top of the window.  

 
5. In the Modify Connection window, update the Email Address or Screen Name and 

Password as appropriate. 
6. Click Connect to QuickBase. 
7. Select your Quickbase application from the list. 
8. Click Test Connection. 

 
9. Click OK. 
10. Click Save Connection. 
11. Click Close in the Connection Settings window. 
12. Retry your Q2QConnect connection as normal. 
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Release Notes 
The following table lists each software release and what changed. We are actively testing and 
developing New/Improved Features and fixing bugs when discovered. (* indicates additional 
license fees may apply). 
 

Version Release Date Release Notes 

3.31.99 08/24/2023 Updated SSL Cert on Executable to resolve “Revoked SSL” Issue with QuickBooks 
desktop 3rd party apps. 

3.31 09/09/2022 Improvement of Multi-User Licensing process* 
Improvement of Multi-QB File feature when switching between QB Files or 
Quickbase accounts* 
Invoice Paid Status and Bill Paid Status updates now ignores “ok to send” setting in 
Quickbase. 

3.29 07/13/2022 Improvement of Multi-User and Multi-QB File Configuration Settings* 
Added ability to change column display width of all fields in Q2QConnect 
Additional under-the-hood improvements for sync speed and error handling 

3.28 02/08/2022 Improvements to Multi-User setup* 
Added the ability to export/import Q2QConnect configuration settings 
Added Multi-QB File Configuration Capability* 
Fixed bug related to QuickBooks default values 
Fixed bug related to entries incorrectly showing as changed 

3.27 06/14/2021 Improvements to sync of billable line items for Bills, Bill Credits, Credit Card 
Charges, and Credit Card Credits 

3.24 06/05/2020 Added Multi User Configuration for Local Machine or Hosting Machine* 
Added Terms and FOB fields to Purchase Orders 
Added Due Date field to Estimates 
Added New Transactions: Bill Credit, Credit Card Charge, Credit Card Credit, Invoice 
Paid Status, Bill Paid Status 
Added Due Date and Currency fields to Sales Orders 
Added Currency field to Invoices 
Added CC Email Address to Customers, Jobs (2nd level customers), and Vendors 
Fixed a bug where Estimate Ship To Addresses were being overwritten even if the 
fields were not mapped 
Solved an issue where Sync ID on Payments not coming over consistently 
Add the ability to use a “-“ character in transaction numbering (e.g. ABC-123) 

 Added CC Email Address to Customers, Jobs (e.g. 2nd level customers), and 
Vendors 

3.19 03/17/2019 Fixed OK To Send on Single Level Customers. 

3.18 02/25/2019 Added Currency and Exchange Rate on Customers, Vendors, and Bills 

3.16 2/8/2019 Added/Fixed sync of Currency & Exchange Rate after updating Invoices exchange 
rate in QuickBooks. 
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3.15 12/20/2018 Fixed intermittent crashing issues when syncing Bills with multiple customer lines 
included in sync. Fixed Payments not updating Q2Q ListID in Quickbase. 

3.10 8/21/2017 Added Sync for Date Paid, Amount Paid on Invoices, Credit Memos, and Bills. 
Added Purchase Order Template mapping. 

3.09 6/28/2017 Added Search for Estimates, Sales Orders, Credit Memos, Payments, Purchase 
Orders, Receipts, Bills. Note: Search not available on lists or Timesheets 

3.07 6/12/2017 Added Sync Back to Base for all transactions, based on Qty change. 
Payments Sync Back if deleted from Books 

3.06 4/11/2017 Added Invoice Sync Back to Base 

3.04 4/2/2017 Added List Filters for Active/Inactive 
Fixed Invoice paid status for line-item detail 
Added Payments Sync 

3.03 3/31/2017 Added Items Sync for the Preferred Vendor and Manufacturer’s Part Number 
fields. 
Added Invoice Paid Status 

3.01 3/25/2017 Added Customer Name search on Customers screen and Invoices Screen 
Added Line Item Sync for Invoices and Credit Memos 
Added paid status for Invoices and Credit Memos 
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